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Introduction 
 
This manual describes the Bioaccumulation Risk Assessment Modeling System (BRAMS) 
program components and features, guides the user in creating both Trophic Trace (TT) and 
Bioaccumulation Evaluation Screening Tool (BEST) models and details the assumptions and 
equations used in each model.  

PART I: Getting Started 
 
1. What is BRAMS?1* 
 
The Bioaccumulation Risk Assessment Modeling System (BRAMS) is a stand-alone tool for 
calculating the potential human health and ecological risks associated with bioaccumulation of 
contaminants in dredged sediments. It contains two separate models, Trophic Trace (TT) and the 
Bioaccumulation Evaluation Screening Tool (BEST), which use separate equations and inputs to 
calculate risks. The stand-alone version of Trophic Trace was updated and recoded for the 
version implemented within BRAMS though it uses the same technical framework and retains all 
the functionality of the stand-alone TrophicTrace version 4.1. The BRAMS program is designed 
to provide health- and ecologically-protective estimates of potential risk using results from 
sediment chemistry tests and/or 28-day bioaccumulation tests. The program calculates the risks 
based on the characteristics of the site including the environment, species and chemicals 
involved, and food chain dynamics and contaminant concentrations.  The user can edit inputs in 
an established template model or create entirely new models based on different trophic 
structures, human and ecological exposure scenarios and site-specific conditions. Model outputs 
include total carcinogenic and non-carcinogenic risks to humans and  toxicity quotients for 
ecological receptors as well as risks from specific chemicals and dietary species. The program 
also compares risks to specified risk thresholds for easy screening. The algorithms incorporated 
into BRAMS follow USEPA and USACE risk assessment guidance (USEPA, 1989; 1997a; 
USEPA/USACE, 1998; Cura et al., 1999). 
 
2. Background 
 

Required by the Marine Protection Research and Sanctuaries Act (MPRSA), the current approach 
for evaluating dredged materials is outlined in the Ocean and Inland Testing Manuals (OTM; ITM) 
(EPA/USACE, 1991; 1998). It involves comparing the bioaccumulation test results of dredged 
materials with reference sediment test results and FDA action levels.  These toxicological 
measures are indicative of a contaminant’s potential for adverse effects to human and ecological 
receptors. The OTM, commonly referred to as the “Green Book,” provides a general protocol for 
evaluating sediment toxicity and determining the suitability of dredged materials for open-water 
disposal. EPA and USACE share the responsibility for regulation of this dredged material. In 

                                                 
1* This section is adapted from the TrophicTrace 4.0 Users Manual. von Stackelberg, K. and A. Burmistrova. 2004. 
TrophicTrace 4.0 Users Manual: A Tool for Assessing Risks from Trophic Transfer of Sediment-Associated 
Contaminants. January 28, 2009. 34 pp. 
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general, the Corps issues permits for dredged material disposal which are then subject to EPA 
review and concurrence before ocean disposal can occur. The tiered approach to evaluation of 
potential environmental impacts of ocean dumping is outlined in the Ocean and Inland Testing 
Manuals (OTM & ITM). BRAMS can be used in Tiers I through IV to provide information about 
potential risks associated with bioaccumulation. Specific guidance for sampling and testing in 
accordance with the OTM and ITM is provided in Regional Implementation Manuals.  
 
Since 1999, EPA Region 1 has evaluated bioaccumulation test results using a screening tool that 
considers whether contaminants accumulated in test organisms might result in a risk to human or 
ecological receptors by direct or indirect consumption (Battelle, 2005). Also in 1999, Menzie-Cura 
& Associates, Inc. developed a mechanistic, process-based bioaccumulation risk model, 
TrophicTrace, to calculate the potential human and ecological impacts of bioaccumulation from 
sediment-associated contaminants (Bridges et al., 2002; von Stackelberg et al., 2004). The 
BRAMS program, released in 2012, includes two fully customizable models, Trophic Trace and 
BEST, based on the 2005 USACE TrophicTrace and the 1999 EPA Region 1 bioaccumulation risk 
assessment model frameworks, respectively. 
 

Trophic Trace (TT): 

In the Trophic Trace model, human and ecological receptors are exposed to potential 
contaminants in dredged materials via ingestion of prey.  The model estimates expected 
concentrations using a sediment-based food web for organic compounds, via trophic transfer 
factors from invertebrates to fish for certain metals, and via bioconcentration factors from water 
to fish for the remaining metals and hydrophilic organic compounds.  Water concentrations are 
estimated using a partitioning approach based on the user-specified sediment concentration or the 
user can input a water concentration directly (the model requires a freely dissolved 
concentration, but can estimate one from an input whole water concentration). Details of the 
model framework are discussed in Part V Section 1. 

 

Uncertainty: Trophic Trace allows users to characterize uncertainty using trapezoidal fuzzy 
numbers (e.g., a minimum, a range of likeliest values or probable values, and a maximum) for 
each input parameter.  These uncertainties are propagated throughout the analysis using 
principles of fuzzy arithmetic.  Model results are also presented as trapezoidal fuzzy numbers 
representing a minimum value, a range of two most probable values, and a maximum value. 
Trapezoidal fuzzy numbers are explained in detail in Part V Section 3. 
 
Included Trophic Trace Example: The BRAMS software includes a Trophic Trace example 
model that contains several human receptor population data libraries built into the demonstration 
form of the model, including recreational anglers (children and adult) in the New York and New 
Jersey (NY/NJ) area, and members of the general public (children and adult).  The example 
exposure assumptions used for these demonstration receptor populations are obtained from the 
USEPA Exposure Factors Handbook (USEPA, 1997a; 1997b) as well as from the New Jersey 
Department of Health (NJDA, 1994). The values provided in the Trophic Trace model are for 
demonstration purposes only. All model runs should be based on site-specific information. The 
Trophic Trace example is also parameterized for several ecological receptors, including fish, 
osprey, bald eagle, mink, and otter. The example food web included in the model is sediment 
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based.  Following the Gobas model, Trophic Trace assumes that organic compounds partition 
from organic carbon in sediment to the lipid fraction of benthic invertebrates.  The example 
model is parameterized for a simple sediment based food web that is representative of a food 
web that might be found in the Northeast Region.  The example invertebrate in Trophic Trace is 
the sandworm (Nereis virens).  The model assumes that a forage fish represented by the 
mummichog (Fundulus heteroclitus), consumes sandworms and that a piscivorous fish 
represented by the summer flounder (Paralichthys dentatus) consumes the mummichog.  The 
user can create additional food webs by modifying or adding invertebrates and fish species, such 
as pelagic invertebrates that derive the bulk of their exposure from the water column, and fish 
that consume both benthic and pelagic invertebrates.  

 
Bioaccumulation Evaluation Screening Tool (BEST): 
 
The BEST model is based on EPA Region 1’s Bioaccumulation Risk Assessment Model 
framework. This model was designed to evaluate dredged material for open water disposal in the 
New England region in accordance with Green Book testing protocol (EPA and USACE, 1991). 
BEST estimates expected concentrations in humans by (1) calculating the edible tissue 
concentration in human diet species including test organisms and their predators, (2) calculating 
an average daily dose to humans that consume these species, and (3) multiplying or dividing 
average daily dose by risk factors (e.g. oral cancer slope factor and oral reference dose) to 
determine potential risks. BEST model framework is discussed in detail in Part V Section 2. In 
the BEST model output, risk results for dredged sediments are compared to reference site risks, 
and acceptable risk thresholds. Calculated tissue concentrations are compared to FDA action 
levels and ecological effects levels. The model can be tailored to each specific project by 
modifying species, food webs and exposure scenarios in templates or creating entirely new 
templates and models. 
 
 
Included BEST Template: The BEST template model included in BRAMS is based on the 
structure and input values of the 1999 EPA Region 1 Bioaccumulation Risk Assessment Model 
(Batelle, 2005). For the standard bioaccumulation risk assessment, the user enters 28-Day 
Bioaccumulation test results for the two invertebrate test species, Macoma nasuta and Nereis 
virens, which have been exposed to either the proposed dredge material or reference sediments. 
The model then calculates predator body burden in a fish fillet, lobster muscle, and lobster 
hepatopancreas. A lifetime daily average dose (LADD) is then determined using standard EPA 
default exposure factors (USEPA, 1989) and regional fish consumption rates (USEPA, 1988; 
Ruffle et al., 1994; RI Department of Health, 1997). Carcinogenic and non-carcinogenic risks to 
human health from fish, lobster, and molluscan shellfish consumption are calculated using 
standard risk factors (e.g. oral CSF, RfD, TEF) for contaminants present at the test site.  
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3. Installation and StartUp 
 

3.1 System Requirements 
 

Central processor Intel Pentium 1GHz or better 
Operational memory 512 MB or more 

Free space on hard disk  20MB 
Operating system Windows XP/Vista/7/10, macOS or Linux 

Third-party software Java Runtime Environment (JRE) Version 8  or later 
 

 
3.2 Installation 

 
 Insert the BRAMS disk into your computer. 
 Locate the BRAMS CD on your Windows disk (D) drive or your Mac Desktop and 

double click it.  
 Drag and drop or Copy and Paste the BRAMS-Dist Folder to the appropriate location on 

your hard drive or run the program directly from the CD.  
 
3.3 StartUp 

 
To open BRAMS, select BRAMS-Dist  bin  BRAMS.jar. Double clicking the file, 
BRAMS.jar, will open the program.  
 
The StartUp window will then appear while BRAMS is loading.  
 
Once BRAMS has finished loading, the User Identification window will appear prompting the 
user to enter their User Name. Enter your User Name and click Continue to continue to the main 
BRAMS window.  
 
The user is now ready to create, edit, and run BRAMS models from the Main Window. 

 
 

4. User Interface 
 
4.1 Main Window 
 
The main BRAMS window includes 9 general sections: 

 Menu 
 Toolbar 
 Explorer Pane 
 Table Pane 
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 Properties Pane 
 Notes Pane 
 Layer  Pane 
 Map Pane 
 Graph Pane 

 
These sections are explained in further detail below in sections 4.2 - 4.7. 
 

 
Figure 1: Main BRAMS Window. 

4.2 Menu 
The menu consists of: 
 
File: Here the user can create, open or save a project or template, change the user, import data 
from Excel files, lock and unlock model inputs and exit the program. 
 

 File:  
o New Project 

 New TT Project 
 New BEST Project 
 New FishRand 

Project       
o Open Project or Template 
o Save Project 
o Save Project As 

o Save Permanently 
o Change User 
o Import  

 Bioaccumulation Test 
Results  

 Chemicals 
o Unlock Project 
o Lock Project 
o Exit 
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                 Figure 2: File Menu. 

 

 
 
Edit: Here the user can access tools for editing script while inputting text into the properties 
pane.  

 
 Edit 

o Undo 
o Redo 
o Copy 
o Paste 
o Cut 
o Delete 

 
 

                 Figure 3: Edit Menu. 

 
 

View: Here the user can change aspects of the main window by choosing to include or remove 
any of the panes (Notes, Explorer, Table, or Properties) or switch to and from full screen 
viewing. 
 

 View 
o Full Screen 
o Panels 

 Тable 
 Graph 
 Properties 
 Map 
 Layer 
 Explorer                                                                  
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 Notes 
 

Figure 4: View Menu. 

 
 
Run: Here the user can choose to perform the TT or BEST model calculations or show the 
Report. The Show Report button will generate the model results and launch the ReportViewer 
window in front of the main window. 
 

 Run 
o Calculate 
o Show Report 

 
 

 

 
          Figure 5: Run Menu. 

 
 
Tools: Here the user can edit several features of the software, including the output format and 
how the templates are generated. 

 
 

 Tools 
o Options 

 Reports 
 Paths 

 Other 
 

 

 
Figure 6: Tools Menu. 

 
Help: Here you can access the BRAMS About window and this User Guide, which describes the 
program components and guides the user in creating, editing, and running bioaccumulation 
models. 
 

 Help 
o User Guide 
o About 
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Figure 7: Help Menu. 

 
 
4.3 Toolbar 
 
 
The toolbar consists of the following buttons: 
 
 

 
Figure 28: BRAMS main toolbar. 

 
Project Tools 
 

 Create new TT project:  Displays the Create New Project window that asks whether the 
user would like to create a new TT project. Selecting No will return you to the main window 
with no changes. Selecting Yes will exit the current project and start a new blank TT project.  

 

Create new BEST project: Displays the Create New Project window that asks whether 
the user would like to create a new BEST project. Selecting No will return you to the main 
window with no changes. Selecting Yes will exit the current project and start a new blank BEST 
project.  
 

 Create new FishRand project: Displays the Create New Project window that asks whether  
user would like to create a new FishRand project. Selecting No will return you to the main 
window with no changes. Selecting Yes will exit the current project and start a new blank 
FishRand project.  
 

 
 

 Open project: Displays the Open Project window where the user can search for, select 
and open an existing project. Once the project has been selected, click Open to open the project. 
To return to the Main window without opening a project, click Cancel. 
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 Save project: If the project has already been saved previously, clicking this button will 
overwrite the previous file and save the updated version under the same name and location. If the 
project has not been saved previously, clicking this button displays the Save Project as… 
window where the user can name and specify a location to save their current project. If the 
project has been saved permanently, this option will not be available because the project file 
cannot be overwritten. 
 

 Save project as: Displays the Save Project as… window where the user can name and 
specify a location to save the current project. 
 

 
Editing Tools 

 

 Back: Undo last action. 
 

 Forward: Redo last action that was undone. 
 

  Cut selected item: Cut selected text. 
 

  Copy selected item: Copy selected text. 
 

  Paste selected item: Paste last Cut or Copied text. 
 

  Remove selected item: Delete selected text. 
 

 
 
Reporting Tools 

 

  Show Detailed Report: If all necessary model parameters have been entered, brings up 
Show Report window. If model is incomplete, information window will appear and explain what 
must be added or corrected before the report can be generated. 
 

   Show Summary Report (BEST Model only):  The summary report shows only a select 
set of results including total carcinogenic and non-carcinogenic risks and contaminant specific 
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risks for each invertebrate, as well as contaminant concentrations compared with FDA Action 
Levels, and Ecological Risk Levels. 

  Show EPA Report (BEST Model only):   EPA Region 1 Report is designed to provide   
comparable results to the bioaccumulation risk analysis report that produced by EPA Region 1.  
Comparable table names from  EPA’s report is shown in parentheses in  table headings for easy 
reference.   
 
 
 

 
4.4 Notes Pane 
 
The Notes pane, located at the bottom of the main window, allows the user to enter text for each 
model item. Once an item is selected from either the Explorer or Table panes, notes about that 
item previously added by the user will appear in the Notes pane. 
 

 
Figure 39: Notes Pane with example text. 

 
4.5 Explorer Pane 
 
The Explorer pane shows the model components and hierarchy. It allows the user to see the 
model items in each category and navigate between different items. 
 
Each of these model components can or must include specific items such as invertebrates, 
chemicals, or environments. Selecting a category (e.g. Invertebrates) or an item (e.g. Worm) in 
the Explorer pane will display all items in that category and selected item properties in the Table 
pane. Selecting an item in the Explorer pane will also display its attributes in the Properties pane. 
 
 
For the TT model, the Explorer pane includes: 
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Figure 410: TT (left) and BEST (right) Explorer Panes. 

 
 
4.6 Table Pane 
 
The Table pane shows all the model items and their certain attributes in the selected category in 
the Explorer pane. Selecting one of the items in the Table pane will display its properties in the 
Properties pane.  
 

 
Figure 511: Example BEST model Table pane showing defined values of characteristics of invertebrates including their Name, 

Lipid Content, and Normalization. 

 
 

 Project 
 Invertebrates 
 Fishes 
 Birds 
 Mammals 
 Human 
 Chemicals 
 Environment 

 
For the BEST model, the Explorer pane 
includes: 
 

 Project 
 Invertebrates 
 Predators 
 Humans 
 Chemicals 
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Figure 612: Example TT model Table pane showing defined characteristics of invertebrates including their Name, Environment, 

Lipid, and Diet Pathway. 

 

4.7 Map Pane 

Map pane brings GIS capabilities to BEST and FishRand projects. For FishRand project  Map 
pane is used to combine areas with the same parameters for calculations. For  BEST project, you 
can specify locations using this pane and also specify concentration samples, used in 28-days 
bioaccumulation tests within  locations for  invertebrates. 
 

 
Figure 13: Map pane. 
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Map pane consists of: 

 Map toolbar contains buttons for the basic operations  with spatial feature layers. 
 Map area.  displays project spatial layers. 
 Map status bar displays information about the current coordinates, the coordinate system 

that is used, etc. 
 

 

map toolbar consists of the following buttons: 
 
 

 
Figure 14: Map toolbar. 

 
Map Tools 
 

 Create Layer: Creates a new spatial layer fot the current project. Create Layer window 
appears asking user to enter the layer name, type, file name on the disk and coordinate reference 
system.  
 

 
                              Figure 15: Create New Layer window. 

 
 

 Open Layer: Displays a standard Java dialog for the spatial layer file selection. It can be 
used to add not only for  layers  that were created by this tool, but also for arbitrary layers. 
Opened and created layers appears the Layer Management pane. 
 

 Remove Layer: Removes a current active spatial layer from  Project.  
 



   18 

 

 Add feature: Adds a new spatial feature to  a currently active layer.  Required user actions 
depend on a layer type. In order to add a new feature to a point-type layer a user should click on 
a map where he/she wants to place a point feature; for  a polygon-type layer he/she should click 
multiple times adding polygon points. 

 

 Select feature: Enables  spatial feature selection mode that works only for an active layer. 
Click on a feature in order to to select it. Selected feature is highlighted with a red color; also the 
selected feature properties will appear in Properties pane.  In order to select multiple features, 
click somewhere on a map, and drag a red selection (rubber)  selecting feature. 
 

 Move feature. Allows to move a feature to a new position. Press the left mouse button on the 
feature and drag and drop it to a new position. 
 
 

 Display full extent: Changes  map scale to fit a map inside of  Map pane. 
 

  Zoom in: Increases  map scale. 
 

 Zoom out: Decreases  map scale. 
 

 Exports bioaccumulation data from spatial layers and imports them BEST model. I; can be 
used with BEST project only. 
 
Use the following steps to export and import 28-days bioaccumulation results. 

1. Create a new location layer. 
2. Add location features  to the new layer. 
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Figure 16: Selected a newly created location feature. 

 
 

3. Create a concentration layer for each invertebrate. Connect the concentration layer with 
the corresponding invertebrate using the Properties pane. 

 
                Figure 17: Linking the concentration layer with an invertebrate. 

 
4. Add concentration features and specify chemical concentrations using the Properties 

pane. The added concentration features should be  inside of previously created location 
features. 
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Figure 18: Created location and concentration layers. Concentrations within the location. 

 

5. Click the  button. 
6. Review the imported from the GIS layers locations and  28-day bioaccumulation results 

with mean and max values . 
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Figure 19: Generated locations. 

 
 

 
Figure 20: Generated 28-days bioaccumulation tests. 

 
 

 

4.8 Layer Pane 
 
 
Layer Management pane allows to change the current active feature layer, change layer order,  
hide layers in Map pane. There are a number of parameters for every layer: visibility, name, 
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color, path to layer file. In order to make a layer active click its row; to hide a layer check off its 
check box. 

 
Figure 21: Added layers to the project. 

 
 
Selected layers  have a number of setting in Properties pane. These settings depend on layer type. 
Using these settings user can change name, color and  other layer properties depending on  layer 
type. 
 

 
Figure 22: Layer properties. 

 
 
 
4.9 Graph Pane 

Graph pane shows food chain starting from invertebrates to humans for BEST and TT 
projects. Food chain is not generated by default when project is opened. IN order to 
generate  food chain for a current project, the refresh button on the Graph pane 
toolbar should be clicked. The generated food chain is  interactive, when user 
clicks on any item it’s getting selected in  Explorer and Properties panels.  

Also, by clicking the  button it is possible to export the food chain to an 
image file. 
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Figure 23: Food chain for the BEST project. 

 
There are a several appearance  settings for  food chain in the Option Dialog. Using these 
properties user can change  food chain layout and species color. 
 

 
Figure 24: Food chain appearance options. 
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Figure 25: Food chain for the TT project. 

 

 
 

4.10 Properties Pane 
 
The Properties pane shows the properties of the selected item. Here, property values can be 
assigned and edited by the user. Editable attributes either have a  button where the user must 
choose from a dropdown menu of possible values, or a  button where the user must directly 
input the values. Once the user selects or inputs the value for an item, it will appear in the Table 
pane. The properties vary for different categories (e.g. Invertebrates vs. Mammals). If the project 
is locked (File  Lock Project), item properties, except for Bioaccumulation Test results, will 
not be editable. To edit these values, the user must unlock the project by selecting File  Unlock 
Project and entering the appropriate password. 
 
For the TT model, the Properties pane includes properties under the categories: 
 

 General – All items 
 Specific – All items 
 Toxicity- Fish, Birds, Mammals 
 Chemical of Concern Table - Environment 
 28-Days Bioaccumulation Test - Invertebrates 
 Diet – Fish, Birds, Mammals, Human 
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Figure 726: Example TT model Properties pane showing input properties of an invertebrate including its Type, Name, 

Environment, Lipid content, Diet Pathway, and Bioaccumulation Test results. 

 
 
 
For the BEST model, the Properties pane includes properties under the categories: 

 
 General – All items and Project 
 Specific – All items 
 Calculation – Humans and Chemicals 
 Diet – Predators and Humans 
 28-Day Bioaccumulation Test – Invertebrates  
 Risk Thresholds – Project 
 Reference Project – Project 
 Levels – Chemicals 
 

 



   26 

 
Figure 827: Example BEST model Properties pane showing input properties of an invertebrate including its Type, Name, Lipid 

content, Normalization, and Bioaccumulation Test results. 

 
4.11 ReportViewer Window 
 
The ReportViewer window shows the results of the risk assessment including risk endpoints 
such as the carcinogenic and non-carcinogenic risks for BEST and TT and NOAELTQ and 
LOAELTQ for TT. It also displays contaminant tissue concentrations and doses for model 
species and human and ecological receptors. Information included in the ReportViewer window 
depends on the model and report type. The ReportViewer appears when the user clicks the  
button or selects Run → Calculate. A summary report is also available for the BEST model, 
which can be accessed by clicking the    button or by selecting Run → Show Summary Report. 
From the ReportViewer window, the user can navigate, adjust, save or print the risk assessment 
results.  
 
4.12 Options Window 
 
Options window allows to change the application general settings: 
 
Trophic Trace 
Show Graphs in Reports: Check on to show charts in the output report. 
Logarithmic scale: Check on to use the logarithmic scale. 
 
BEST 
Show Zero Values: Check on to show zero rows in BEST reports. 
Show Group Total: Check on to enable total group rows (see grouping) in BEST reports. 
Show Group Detailed: Check on to enable total detailed rows (see grouping) in BEST reports. 
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Graph 
Layout Option: Changes layout option (layout type) that is used automatically generating and 
placing food chain items. 
Show Singles: Check on to show species that are not involved in  food chain. 
Human, Predator, Prey Color: Changes the color of the corresponding species nodes. 
 
Map 
Select Stroke Color: Changes the stroke color of selected features. 
Select Fill Color: Changes the fill color of selected features. 
 
 
 

 
Figure 28: Options window. 
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Figure 929: Example TT model ReportViewer window page 1. 
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PART II: Building the Model 
 
For a quick, step by step guide to creating BRAMS models, see Part IV - Step By Step Model 
Creation. 
 
 
1. User Identification  
 

Users should identify themselves by entering their user name in the User Identification window. 
To access this window, select File  Change User. When opening BRAMS for the first time the 
User Identification window will appear automatically prompting the user to enter their User 
Name. This User Name will appear on the last page of the Reports. 
 

2. Create or open a project or template 
 

 
Create a new project: 
 
BEST: From the main window select File → New Project → New BEST Project from the Menu 

bar or click  in the toolbar. Then select Yes when the Create new project window appears. 
 
TT: From the main window select File → New Project → New TT Project from the Menu bar or 

click  in the toolbar. Then select Yes when the Create new project window appears 
 
FishRand: From the main window select File → New Project → New FishRand Project from the 

Menu bar or click  in the toolbar. Then select Yes when the Create new project window 
appears. 
 
To open an existing model or template: 
 
From the main window select File → Open Project or Template or click , and then choose an 
existing model from the Open Project window. 
 

 
5. Add a new item  
 
In the Explorer pane, select the item category you wish to add to (e.g. Chemicals) then click  
in the Table pane to add a new item to that category. A new item will appear in the Explorer 
pane under the selected category and in the Table pane with default values for the item’s 
properties. Items can be added to the model in any order but item properties must be input in the 
order specified in section 4.1 below. 
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BEST model: Inputs other than Bioaccumulation Test results may be password protected if the 
project has been locked. If so, the project must be unlocked to edit inputs. To lock or unlock a 
project, see Part II Section 6. 
 
6. Add or edit project and item properties 
 
6.1 General 
 
For each item, the user must specify values for each property in the Properties pane. Because 
some value choices depend on other inputs, add property values to items in each category in the 
Properties Pane in the order: 
 
 
BEST:  1. Chemicals  

       2. Invertebrates  
       3. Predators  
       4. Humans 
       5. Locations 
 

BEST model: Inputs other than Bioaccumulation Test results may be password protected if the 
project has been locked. If so, the project must be unlocked to edit inputs. To lock or unlock a 
project, see Part II Section 6. 

 
TT:       1. Chemicals 

 2. Environment 
 3. Invertebrates 
 4. Fish 
 5. Birds, Mammals, or Humans 
 6. Environment 

 
 
BRAMS properties may be input using one of these four input methods: 
 
Excel Input (BEST Model Only): Some Project, Chemical and Invertebrate items and 
properties are imported into the current BEST project directly from selected Microsoft (MS) 
Excel files with the appropriate format. See Part II section 4.3 for a complete description of the 
MS Excel Input method and input formats. MS Excel input templates are also included in the 
BRAMS software package. 
 
Text Box: Click inside the text box directly right of the property name; delete any unwanted text 
and type new text.  
 
Drop Down Menu : 
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Click  to the right to of the property you wish to edit to view possible choices. Double click the 
appropriate choice.  
 
Add Button :  
 
Click  to the right of the property you wish to edit. This will either display a drop-down 
window with four possible numerical inputs (for parameter uncertainty in TT models only) or a 
drop down table with information relating the current item to another item type (e.g. 
Concentrations of specific Chemicals in specific Invertebrate’s tissue according to the 28-day 
Bioaccumulation test). After clicking , add values depending on the property type:  
 
Independent Numerical Values – Double click the specific input value in the dropdown 
window that you wish to edit, delete the current value and enter the new value.  
 

Other Item Dependent Values - Click  in the bottom right corner of the drop down table to 
add an existing item from within the related item category. Then click  below the new item 
category to see the list of existing items. Choose one of the existing items by double clicking it. 
Next, specify values for each attribute by double clicking the cell corresponding to each and 

entering the desired value. Click  to delete an item from the list. 
 
6.2 By model type and item category 
 
4.2.1 BEST model: 
 
To edit an item’s properties: 

(1) In the Explorer pane, select the item category. 
(2) In the Table pane, select the specific item.  
(3) In the Properties pane, edit properties as described below. 

 
Project properties: 
 
General: 
Specify the Project Name, Project Number by either, (1) clicking inside the text boxes to the 
right of each corresponding property name, deleting any contents, and entering the appropriate 
data or (2) importing the data from the 28-day Bioaccumulation Test Results Excel sheet (See 
Part II section 4.3 on Excel Inputs). 
 
 
Risk Thresholds: 
Enter carcinogenic and non-carcinogenic risk thresholds in the General Project Properties pane 
by clicking inside the corresponding text boxes and entering values. Calculated risk levels 
exceeding these thresholds will be highlighted in red in the Total Risks and Contaminant 
Specific Risks sections of the BEST Summary Report. Also, you can specify  Number of 
Measurements that affects  number of concentration samples in  bioaccumulation test results for 
every location. 
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Reference: (For Optional Test and Reference site risk comparison):  
Select  reference location for  project from the drop down list, which is populated with  of 
avilable locationsfrom bioaccumulation results file. 
List of which chemicals that should be included to  risk estimation should be selected for each 
individual sediment location, except reference one.  The list of chemicals that is used in 
calculations for reference location will  reproduce the list used that is used for sampling location 
for which the reference is serving as a basis for comparison.   
 
Daily Dose Settings: User can control whether Average Daily Dose, or Lifetime Average Daily 
Dose should be used for Summary and EPA reports. 
 
 
 
 

 

 
Figure 30: BEST project properties. 

 
 
Item properties: 
 
For each item, the user must specify property values within the property categories including: 
 

 General – All items 
 Calculation – Humans and Chemicals 
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 Specific – All items 
 Diet – Predators and Humans 
 28-Day Bioaccumulation Test – Invertebrates  
 Levels – Chemicals 

 
 
While the item you wish to edit is selected in the Table Pane, specify its properties by entering 
values into the boxes within the Properties pane.  
 
Chemicals: All chemical data can be entered automatically by importing the data from the 
Chemical Input Excel sheet (See Part II section 4.3 on Excel Inputs). To enter chemical data 
manually, follow the directions below. If the value of any property is unknown, enter NA in the 
text box (default value). 
 
General: 

(1) Name: Specify the name of the item by clicking inside the text box to the right of Name, 
deleting the current name, and typing a new one.  

 
Calculation:  

(2) Calculating: Specify whether or not to include the chemical in the model calculations. 
Check the box to the right of to include the item, uncheck the box to exclude the item. 
 

(3) TEF Reference Chemical: Specify whether the chemical is a TEF Reference Chemical 
(ex. 2,3,7,8-TCDD and benzo(a)pyrene) by checking (Yes) or un-checking (No) the box 
to the right of Reference Chemical. Chemicals designated as TEF reference chemicals 
will then be added to the TEF calculation drop down menu.  

 
(4) TEF Relation: Specify if or how a Human Toxicity Equivalency Factor (TEF) applies. 

Select NA for all items that do not have a TEF (NA is the default value). For items such 
as individual dioxin congeners, coplanar PCB compounds and selected PAH compounds 
that have assigned TEF values, select the reference chemical their TEF applies to. This 
information can be entered manually or imported directly from a Chemical Excel file. To 
enter TEF information by importing from Excel, see Part II Section 3.3. To enter TEF 
information manually, click  to the right of TEF to display a dropdown menu of 
possible TEF choices. See Part V Section 2.3 for additional information on TEF 
application to chemicals in the BEST model. 
 

Grouping: 
(5) Total Chemical:  Marks  chemical as total group. Total group chemical is used only for 

grouping and does not appear in any calculations.  
 

(6) Grouping Chemical: Selects the chemical group from the drop-down menu, only total 
chemicals are shown there. Depending on the settings either every single non-total 
chemical is shown in the reports or chemicals results are grouped by total chemical. 
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Specific: 
(7) Chemical Type:  Click  to specify whether the chemical is Organic or Metal. Organic 

and metal contaminant transfer are calculated differently.  
 

(8) Cancer Slope Factor (mg/kg-day)-1: Specify the Oral Cancer Slope factor associated with 
the chemical by clicking inside the textbox and entering the appropriate value. This value 
will be used to determine Carcinogenic Risk. 

 
(9) Reference Dose (mg/kg-day): Specify the Reference Dose associated with the chemical 

by clicking inside the textbox and entering the appropriate value. This value will be used 
to determine Noncarcinogenic Risk. 

 
(10) Biomagnification Factor: Specify the Reference Dose associated with the 

chemical by clicking inside the textbox and entering the appropriate value. This value 
will be used to determine contaminant transfer from invertebrates to predators. 

 
(11) Human Toxicity Equivalence Factor: If a TEF does not apply, the selected 

chemical should have ‘N/A’ selected in the TEF Relation property field above and ‘NA’ 
will appear in the Human Toxicity Equivalence Factor text box. If a TEF does apply, 
click inside the textbox and enter the appropriate TEF value relating this chemical’s 
toxicity to a chemical of known toxicity. 
 

(10) Steady State Correction Factor: Specify the steady state correction factor associated with 
the chemical by clicking inside the textbox and entering the appropriate value. This value 
will be used to correct for underestimates of contaminant transfer from sediment to 
invertebrates during 28-day bioaccumulation testing. 
 

Levels: 
(11) FDA Action Level: Specify the FDA Action Level (ppm) associated with the chemical 

by clicking inside the textbox and entering the appropriate value.  
 

(12) Ecological Effect Level: Specify the Ecological Effect Level (ppm) associated with the 
chemical by clicking inside the textbox and entering the appropriate value. 

 
(13) FDA Level of Concern: Specify the FDA Level of Concern Level (ppm) associated with 

the chemical by clicking inside the textbox and entering the appropriate value. 
 

 
 
Invertebrates: 
 
General: 

(1) Name: Specify the name of the item by clicking inside the text box to the right of Name, 
deleting the current name, and typing a new one.  

Grouping: 
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(2) Group Category:  BEST can aggregate results; in order to indicate which items in trophic 
level should be summed in report, their group (shared) name should be assigned. 

Specific: 
(3) Lipid: Specify the invertebrate’s lipid content (g lipid/g tissue) by clicking inside the text 

box, deleting the current value and entering the new value. 
 
28-Days Bioaccumulation Test: 

(4) Bioaccumulation Test: There are two ways to enter 28-day bioaccumulation test data:  
a. Import data directly from a 28-day Bioaccumulation Test Results Excel sheet as 

described in Part II Section 4.3 or 
b. Enter the data manually by first clicking  to display a drop down window where 

you can add chemicals from the Chemicals category and Mean and Max Tissue 
Concentrations. Then click  in the bottom right corner of the drop down 
window to add a new row. Next, click  in the Chemical column of the new row 
to choose from the existing chemicals. Finally, specify values for Mean Tissue 
Concentration and Max Tissue Concentration by double clicking the 
corresponding cells and typing their values. Organic tissue concentrations should 
be in units of ng/g, while metal tissue concentrations should be in units of µg/g. 
Click  to delete a chemical from the table.  
 

 
Figure 31: BEST invertebrate properties. 

 
 
  
Predators: 
 
General: 

(1) Name: Specify the name of the item by clicking inside the text box to the right of Name, 
deleting the current name, and typing a new one.  

Grouping: 
(2) Group Category: BEST can aggregate results; in order to indicate which items in trophic 

level should be summed in report, their group (shared) name should be assigned. 
 

Specific: 
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(3) Lipid: Specify the invertebrate’s lipid content (g lipid/g tissue) by clicking inside the text 
box, deleting the current value and entering the new value. 

 
Diet: 

(4) Predator Diet: First click  to display a drop-down window where you can add each 

predator’s potential prey species. Click  in the bottom right corner of the drop-down 
window to add a new prey species. Then click  to the right of the new row to specify 
which of the existing Invertebrate species to add.  
 

 
Figure 32: BEST predator properties. 

 
 

Humans: 
 
General: 

(1) Name: Specify the name of the item by clicking inside the text box to the right of Name, 
deleting the current name, and typing a new one.  

 
Calculation: 

(2) Calculating: Specify whether or not to include the item in the model calculations. Check 
the box to the right of Calculating to include the item, uncheck the box to exclude the 
item from the model calculations. 
 

Specific: 
(3) Body Weight: Specify the human’s body weight in kilograms by clicking inside the text 

box, deleting the current value and entering the new value. 
(4) Averaging Time: Specify the averaging time in days to be used in the human’s average 

daily dose calculation by clicking inside the text box, deleting the current value and 
entering the new value. 

 
Diet: 

(5) Human Diet: Click  to display a drop-down table where you can add species that make 
up the selected human’s diet. Click  in the bottom right corner of the table to add a new 
row. Then click  below the Prey column in the new row to choose from the existing 
lower trophic level species. Then specify values for fraction ingested, frequency 
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(days/year), ingestion rate (kg/day), and exposure duration (years), by double clicking the 
space below each and entering the appropriate values. These values will be used to 

calculate the human’s average daily dose of contaminants in each diet species. Click   
to delete a row from the list.  

 
Figure 33: BEST human properties. 

 
 
 
4.2.2 TT Model:  
 
For each item, the user must specify property values within three or more categories including: 
 

 General – All items 
 Specific – All items 
 28-Days Bioaccumulation Test - Invertebrates 
 Diet – Fish, Birds, Mammals, Human 
 Toxicity- Fish, Birds, Mammals 
 Chemical of Concern Table - Environment 

 
While the item you wish to edit is selected, specify its properties by entering values into the 
boxes within the Properties pane. For each Properties category, follow the directions below. 
 
General: 
 

Specify the name of the item by clicking the box to the right of Name, deleting the 
current name, and typing a new one. Specify the environment by clicking the  then the 
appropriate environment type. 

 
Specific: 
 

Specify values in the Specific category by clicking  to the right of the characteristic 
you wish to edit. This will display a drop-down window with four possible inputs. 
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Double click the input value you wish to edit, delete the current value and enter the new 
value. If the input value is known with certainty, simply enter the known value in all four 
spaces. If the input value is uncertain, enter four values representing the range of 
possibilities according to trapezoidal fuzzy numbering (See Part V Section 3). Or, for 
some input categories, (Invertebrates-Diet Pathway, Fish-Trophic Level and Reference 
Invertebrate, Chemicals- Chemical Type) click the  to the right to of the characteristic 
you wish to edit to display a drop-down menu of pre-specified choices and click the 
desired choice. 

 
28-Days Bioaccumulation Test: 
 

For items in the Invertebrates category, specify Bioaccumulation Test values by clicking  
to the right of Bioaccumulation Test. This will display a drop-down window where you can 
input chemicals, their concentrations and whether or not steady state applies. To add a 

chemical, click  in the bottom right corner of the drop-down window. Then click the  in 
the new row below Chemical, this will display the list of chemicals that have previously been 
added to the Chemicals category. Click the chemical you wish to add information about and 
it will appear on the list. Then double click the box corresponding to its concentration. Now 
you can either add one, certain value by typing it in the box or add four values for uncertain 
inputs by clicking  to the right of the box and entering the values according to trapezoidal 
fuzzy numbering (See Part V Section 3).  Next, if steady state applies, check the box below 
Steady State Applies. If it does not apply, leave the box blank. 

 
Diet: 

 
For items in the Fishes, Birds, Mammals and Human categories, specify Diet properties by 
clicking  to the right of Diet. This will display a drop-down window where you can input 
the selected item’s prey species, and the percent of their diet each makes up. To add a prey 
species, click  button in the bottom right corner of the drop-down window. Then click the 

 in the new row below Prey, to will display the list of potential prey species that have 
previously been added to the model. Click the species that make up the selected item’s diet 
and they will appear on the list. Then double click the Percent box and type the percent of the 
selected item’s diet that each prey species makes up. Enter prey species until the total diet 
percent adds up to 100. 
 

Toxicity: 
 

For items in the Fishes, Birds, and Mammals categories, specify Toxicity properties by 
clicking  to the right of Toxicity and, for Fishes and Birds, Eggs Toxicity. For both, this 
will display a drop-down window where you can input chemicals, and their NOAEL and 
LOAEL Residue values. To add a chemical, click  in the bottom right corner of the drop-
down window then  below the Chemical category in the dropdown window. This will 
display the list of chemicals that have previously been added to the Chemicals category. 
Click the chemical you wish to add information about and it will appear on the list. Then 
double click the box corresponding to NOAEL Residue. Now you can either add one, certain 
value by typing it in the box or add four values for uncertain inputs by clicking  to the right 
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of the box and entering the values according to trapezoidal fuzzy numbering (See Part V 
Section 3). Next add values to LOAEL Residue in the same way. 

 
Chemical of Concern Table: 
 

For items in the Environment category, specify Chemical of Concern properties by clicking 
 to the right of Chemical of Concern. This will display a drop-down window where you 

can input chemicals, and their concentrations in water and sediment. To add a chemical, 
click the green Insert Row button in the bottom right corner of the drop-down window, and 
then click  below the Chemical category in the dropdown window. This will display the 
list of chemicals that have previously been added to the Chemicals category. Click the 
chemical you wish to add information about and it will appear on the list. First specify 
whether you will enter the Total or the Dissolved concentration by clicking  below 
Concentration Type in the dropdown window and then clicking either Total or Dissolved. 
Then, for both the Water and Sediment categories, double click the boxes corresponding to 
each and either add one, certain value by typing it in the box or add four values for uncertain 
inputs by clicking  to the right of the box and entering the values according to trapezoidal 
fuzzy numbering (See Part V Section 3).  

 
 
6.3 Import Data From Excel (BEST Model) 
 
Invertebrates and their 28-day Bioaccumulation Test Results as well as Chemicals and all 
chemical properties can be entered directly into a BEST model by importing values from 
Microsoft Excel spreadsheets according to established templates. In order for BRAMS to read 
the values correctly, they must be uploaded in accordance with specific Excel templates included 
in the BRAMS software package.  Templates for the 28-day Bioaccumulation Test Input and 
Chemicals Input are provided with the software package and shown below in figures 9-11. To 
add certain invertebrate or chemical items (e.g. Macoma nasuta) or properties (e.g. Mean Tissue 
Concentration from 28-day Bioaccumulation Test results for “Lead” in “Macoma nasuta”) the 
Chemical and Invertebrate names must match those in the model exactly, otherwise new items 
will be created. 
 
Once all desired values have been correctly entered into the Excel Input templates, select File → 
Import  Import Bioaccumulation Results or Import Chemicals. The Open Excel window will 
appear where you can select the appropriate Excel file. Once you have selected the desired file, 
click Open. The window will then close and the data within the selected Excel file will be added 
to the model. 
 
Chemical Inputs should be entered in the format shown in Figure 10 and Figure 11 below.  
Properties of each chemical (e.g. Oral Cancer Slope Factor, Oral Reference Dose, 
Biomagnification Factor, etc.) entered here will be automatically entered into the Chemicals 
section. NA will be assigned to properties, which either have the value, ‘NA’ or that have no 
contents in the corresponding Excel cells. If chemical properties that correspond to blank cells in 
Excel appear as ‘0’ instead of ‘NA’ once imported into BRAMS, go back to the cells and use the 
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Excel function ‘Clear Contents’ to empty the cells. An extensive chemical library is included in 
the BRAMS package and in the included BEST template file.  
 

 
Figure 3410: Excel Chemicals Input Sheet, Columns A-E. 

 

 
Figure 3511: Excel Chemicals Input Sheet, Columns F-K. 

 
The 28-day Bioaccumulation Test Results must be input into the software in the format shown 
in Figure 12.  The user must include the organism, contaminant, mean tissue concentration and 
maximum tissue concentration as well as the Project Name, Project Number and Location. For 
unit consistency, [Tissue]/Normalization Factor must equal units of mg/kg. For example if the 
Normalization Factor (Invertebrate property) = 1000, enter tissue concentration in ng/g. If the 
Normalization Factor (Invertebrate property) = 1, enter tissue concentration in µg/g. 
 

 
Figure 3612: Excel Bioaccumulation Test Results Input Sheet 

 
7. Using Templates 

  
Using templates as a base to build each project model from saves time and effort and ensures 
consistency between related projects. Instead of entering all items and properties for each new 
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project, templates allow the user to start with all or most of the project components, except for 
certain project specific data, already entered into the model. Included BRAMS templates can be 
found in the Examples folder. Once a template has been created, values can be protected by 
locking the model or saving it permanently. 
 
 
8. Locking and Unlocking BEST Model Properties 
 
The majority of BEST model users should base their risk assessment models on templates with 
established property values and should only need to edit the 28-days Bioaccumulation Test 
Results. To prevent users from changing the established values (e.g. Lipid content of N. virens, 
Oral Cancer Slope Factor of DDT), these values can be locked. Property values other than 28 
Day Bioaccumulation Results will become grayed-out and password protected.  
 
Lock:  To lock a project, select File  Lock Project. This will display the Password Protection 
window where the user should enter a password and click continue.  
 
Unlock: To unlock a project, select File  Unlock Project. This will display the Password 
Protection window where the user should enter the previously set password and click continue.  
Property values should once again be freely editable.  
 

 
9. Saving Permanently  

 
The Save Permanently feature allows users to save a project file so that it cannot be overwritten. 
A permanently saved file can be accessed and edited but then must be saved under a different 
name. This feature is designed to preserve templates for future use and finalized projects for 
future review. 
 
To save a file permanently, select File  Save permanently. This will display the usual Save 
Project As…  window where the user can name and specify a location to save the current project 
permanently.  
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Part III:  Results 
 
1. Generate Report 
 
Once all items and their properties necessary for the risk assessment have been specified, click 
either Run → Calculate or Run  Show Report in the Menu or click the Show Report button 

in the Toolbar to generate the report. An additional summary and EPA reports are available 
for the BEST model. The summary report can be accessed by selecting Run  Calculate 

Summary Report or clicking the Show Summary Report button . EPA report can be 
accessed by selecting Run  Calculate EPA Report or clicking Show EPA Report button .  
The ReportViewer window will then appear showing results of the model analysis. The different 
outputs for TT and BEST are detailed in Section 2 below. Reports can be exported to multiple 
file formats by selecting File → Export Report or printed by selecting File → Print Report.  
 
10. Outputs 

 
  
Trophic Trace  
 
Trophic Trace evaluates risks with different endpoints for humans and ecological receptors.  
 
Every report contains a brief description of the model it is based on. 

 
Figure 37: TT Brief model description. 

 
For a given ecological receptor, the Trophic Trace output report  will first provide a description 
of the receptor including its name, body weight, lipid content and site use factor. For human 
receptors, the output first shows the human’s name, weight, lifespan and diet information. 
 

 
Figure 3813: TT ecological receptor properties report section. 
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Next, the output displays the receptor’s “Risk List.” For ecological receptors, this section 
identifies the chemical names, calculation method, NOAEL TQ, LOAEL TQ, NOAEL TQ for 
eggs, and LOAEL TQ for eggs.  For human receptors, the Risk List section shows the calculation 
method, incremental lifetime cancer risk (LCR), and noncarcinogenic hazard index (Hazard) 
from each chemical. 

 

 
Figure 3914: TT ecological receptor Risk List report section. 

 
The next set of information displayed for each ecological and human  receptor is the “Exposure 
Concentration.”  Included as part of this are diet items, the environment, diet percent, chemical, 
and concentration of that chemical.     
 



   45 

 

 
Figure 4015: TT Exposure Concentration report section. 
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The last section included in the Trophic Trace output report is a graphical representation of the 
risks including uncertainty bounds. For ecological receptors this includes NOAEL TQ, LOAEL 
TQ, NOAEL TQ eggs, and LOAEL TQ eggs, for each of the chemicals present at the site.  For 
human receptors, this includes LCR and Hazard for each of the chemicals present at the site. 
 

 
Figure 4116: TT Risk Figures report section for ecological receptor. 
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BEST 
 

 The BEST model has three options for output reports:  the Summary Report, the Full 

Report, and the EPA Report.  The Summary Report can be generated by clicking  while 

the Full Report is generated by clicking  . And the EPA Report is generated by clicking 
. 
 
Summary Report  
Summary report compares risk estimates from sediment sample locations to those of the project 
reference site, both for total risk and contaminant specific risks.  
**Important: The Summary Report results for non-cancer risks are calculated using average 
daily dose whereas EPA Region 1 Report results are calculated using lifetime average daily dose.  
See Error! Reference source not found. for the formulas.  
Summary report includes the following section for each location-invertebrate pair: 
Total Carcinogenic and Non-Carcinogenic Risks – reports total cancer risk and non-cancer 
risks in each human diet species for both the test and reference sites 

 

Figure 42: Total Carcinogenic and Non-Carcinogenic Risks report section. 

FDA Action and Ecological Risk Levels – reports  mean tissue concentration and steady state 
corrected mean tissue concentration for chemicals in the current invertebrate, along with three 
thresholds: FDA action level, ecological effect level, and FDA level of concern, for comparison 
purposes 

 

Figure 43: FDA Action and Ecological Risk Levels report section. 
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Contaminant Specific Carcinogenic and Non-Carcinogenic Risks – reports  cancer and non-
cancer risks from each individual chemical in each of  human diet species for  test and reference 
sites 
 
 
 

 
Figure 1744: Contaminant Specific Carcinogenic and Non-Carcinogenic Risks report sections. 

   
EPA Region 1 Report 

 EPA Region 1 Report is designed to be  comparable to  bioaccumulation risk analysis report 
produced by EPA Region 1.  Comparable table from the EPA’s report is in parentheses in  table 
headings for  reference.   
**Important: risk estimates report on those chemicals that are selected by the user (see Select 
Chemicals of Concern) 
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**Important: threshold tables report on any chemical that has a threshold and appears in the 
bioaccumulation lab results, regardless  if it is selected as a chemical of concern 
Total Estimated Risks From Organics (see EPA Table Xa) - compares total risk estimates 
from sediment sample locations to those of  project reference site 

 

Figure 45: Total Estimated Risks from Organics report section. 

Seafood Non-Cancer Risks (see EPA Table 6a, Columns F & G) – reports non-cancer risk from individual 
metal of concern along with reference location results 

 

Figure 46: Seafood Non-Cancer Risks report section. 

FDA Action Limit/ Tolerance (see EPA Table 3, Columns D & E) – reports the FDA 
threshold value of organics (and mercury) along with  steady state corrected mean tissue 
concentration in the current invertebrate 

 

Figure 47: FDA Action Limit/ Tolerance report section. 

Ecological Effect Level - reports  ecological effect threshold of individual chemicals along with  
steady state corrected mean tissue concentration in the current invertebrate 
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Figure 48: Ecological Effect Level report section. 

FDA Level of Concern - reports  FDA threshold value of metals along with  steady state 
corrected mean tissue concentration in the current invertebrate 

 

Figure 49: FDA Level of Concern report section. 

Full Report  
Full report includes the following sections for each location-invertebrate pair:   
Selected chemicals –  contains  list of selected chemicals per location. 
 

 

Figure 50: Selected chemicals report section. 

Diet Report – reports  cancer risk and the non-cancer risk associated with each human diet 
species 
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Figure 51: Diet report section. 

Prey Report – reports  cancer risk and  non-cancer risk associated with each prey-predator-
human exposure pathway 

 

Figure 52: Prey report section. 

Chemical Report – reports  cancer risk and non-cancer risk associated with each chemical of 
concern via each human diet chain, along with intermediate calculations; edible tissue 
concentration, average daily dose, and lifetime average daily dose 

 

Figure 53: Chemical report section. 
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18 

 
 
BEST reports are also stamped with the version of the software, the date, and the name of the 
user who ran that iteration of the software.  This provides better record keeping for BRAMS 
users. 
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Figure 5419: BEST Model Report Identification section. 
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Part IV:  Step by Step Model Creation  
 
This section presents simple, step by step instructions to create and run BRAMS models to 
conduct bioaccumulation risk assessments. A more detailed description of BRAMS components, 
and model building and editing is presented in Section II.  
 
1. BEST Model 
 
Below is an example of how to quickly, and efficiently run a Bioaccumulation Risk Assessment 
using the BEST model. In this example, the user will first create a BEST model for a reference 
site then create a BEST model for a project test site, and finally generate results that compare the 
two sites. 
 
This example assumes the user has the following: 
 

(1) The BRAMS software package saved to the computer. If not, see Part I Section 2.2. 
(2) The appropriate BEST template file (.best) with all or most necessary project inputs 

except 28-day bioaccumulation testing results. See Part II Section 5 for an explanation of 
BRAMS templates. See Part II Section 4.2.1 for a detailed instruction of how to create a 
new model or template starting with a blank model. 

(3) Completed Bioaccumulation Test Result Excel files for the project test and reference 
sites. If not, see Part II Section 4.3. 

 
Once the user has these items, they may proceed to Step one. 
 
STEP ONE: Getting Started  
 

 Open the BRAMS software by running the executable file BRAMS.jar. 
 

 The StartUp window will then appear while BRAMS is loading.  
 

 If this is the first time the program has been opened, once BRAMS has finished loading, 
the User Identification window will appear prompting the user to enter their User Name. 
Enter your User Name and click Continue to continue to the main BRAMS window.  

 
 If BRAMS has been previously opened on this computer, the Main Window will appear 

automatically and the previously entered User Name will be used. 
 

 From the Main Window, the user is now ready to create, open, edit, and run BRAMS 
models. 

   
STEP TWO:  Open the appropriate BEST template file  
 

 From the main menu select File → Open Project or Template or click  in the toolbar. 
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 The Open Project window will appear where the user should locate and select the 
appropriate BEST template file for the current project. Once the template file has been 
selected, click Open to load the BEST template file data. 

 
STEP THREE (Optional):  Add or Edit Items and Properties 
 
If the project requires any changes to model items or properties from the selected template 
model, make changes in the following way: 

 
 Add or delete project items:  

o In the Explorer Pane, click and highlight the item category you wish to edit. Items 
in this category will then appear in the Table Pane. 

o In the Table Pane, Click  to create a new item in the selected category.  In the 
Properties Pane, enter the name of the item in the Name text box. 

o To delete an item, select it and click .  
 

 Edit item or project properties: 
o In the Explorer Pane, select the category of the item you wish to enter properties 

for or select the Project category. 
 Project category: Project properties will appear in the Properties Pane. 
 Item categories: Select the specific item you wish to edit properties for in 

the Table Pane. The selected item’s properties will then appear in the 
Properties Pane. 

o In the Properties Pane, edit any properties.  
 For those properties with a : Click the  and select an item from the drop 

down menu. 
 For those properties with a :  

 Numerical values: If the input value is known with certainty, 
simply enter the known value in the text box. If the input value is 
uncertain, click the  and enter four values representing the range 
of possibilities according to trapezoidal fuzzy numbering (See 
section Part IV section 3). 

 Tables: Click the  next to the property. A table will appear 
where you can input related items by clicking  and selecting 
from a drop down menu of options. Then specify any remaining 
information in the table relating the items in the property table to 
the selected item. 

 For those properties with a : Click inside the box to check or uncheck 
the box. 

o Continue editing until all project specific item and property changes have been 
made. 

 
 
STEP FOUR:  Import 28 Day Bioaccumulation Reference Data 
 

 In the main menu, select File  Import   Import Bioaccumulation Results.   
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 The Open Excel window will then appear. Locate and select the Bioaccumulation Test 

Result Excel file containing project reference data and click Open.  
 

 The Import Mode window will then appear, click Yes to import the data. 
 

 Reference site data within the imported Bioaccumulation Test Result Excel file should 
now appear in the 28-days Bioaccumulation Test properties for each Invertabrate 
included in the test and general project properties should appear in the Project Properties 
pane. 

 
STEP FIVE:  Name and save the reference site project 
 

 From the main menu select File → Save Project As or click  to name and save the 
project. Be careful not to overwrite the template file. 
 

 The Save Project As… window will appear prompting the user to assign a name and 
location to save the new BEST reference project. Select the desired location and name the 
project, then click Save.  This will save the project and return you to the Main Window. 
 

STEP SIX:  Import 28 Day Bioaccumulation Test Data 
 

 In the main menu, select File  Import   Import Bioaccumulation Results.   
 

 The Open Excel window will then appear. Locate and select the Bioaccumulation Test 
Result Excel file containing project test site data and click Open.  

 
 The Import Mode window will then appear, click Yes to import the data. 

 
 Test site data within the imported Bioaccumulation Test Result Excel file should now 

appear in the 28-days Bioaccumulation Test properties for each Invertabrate included in 
the test and general project properties should appear in the Project Properties pane. 
 

STEP FIVE:  Name and save the test site project 
 

 From the main menu select File → Save Project As or click  to name and save the 
project.  Be careful not to overwrite the reference site file. 
 

 The Save Project As… window will appear prompting the user to assign a name and 
location to save the new BEST reference project. Select the desired location and name the 
project, then click Save.  This will save the project and return you to the Main Window. 

 
 
STEP SEVEN: Specify Reference Project 
 



   57 

 In the Explorer pane, click the main Project category (the first category in the Explorer 
Pane). 

 In the Properties Pane, click  to the right of Reference Project in the Reference section.  
 The Open window will appear where you can search for and select the file corresponding 

to the reference site, then click Open. 
 The reference project file should now appear in the Reference project input box. 

 
STEP EIGHT: Save the completed test site project 
 

 From the main menu select File → Save Project or click  to overwrite the previous file 
and save the current project.  

 
STEP NINE:  Calculate and display results 
 

 Click   to run the model calculations and view the detailed report or click  to run 
the model calculations and view the summary report. After the calculation has completed, 
the Report window will appear showing risk assessment results for the project. 

 
STEP TEN:  Save Results 

 
 In the Report window, save the project risk assessment results by clicking . 

 
 
 
11. Trophic Trace Model 
  
This section presents simple, step by step instructions to create and run a TT model. In this 
example, the user will develop an entirely new TT model. Alternatively, if an appropriate 
template model is available, the user should begin with a template model similar to the method in 
the BEST model step by step example above.  
 
 
STEP ONE: Getting Started  
 

 Open the BRAMS software by running the executable file BRAMS.jar. 
 

 The StartUp window will then appear while BRAMS is loading.  
 

 If this is the first time the program has been opened, once BRAMS has finished loading, 
the User Identification window will appear prompting the user to enter their User Name. 
Enter your User Name and click Continue to continue to the main BRAMS window.  

 
 If BRAMS has been previously opened on this computer, the Main Window will appear 

and the previously entered User Name will be used. 
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 From the Main Window, the user is now ready to create, open, edit, and run BRAMS 
models. 

 
STEP TWO:  Open a new TT project 
 

 Click   to open a new Trophic Trace project. The blank Trophic Trace framework will 
then appear in the BRAMS panes. 
 

 As mentioned previously, the user can also begin with an appropriate template model 
when available. To load a template model, simply click  in the toolbar and select the 
template file in the Open window. 

 
 
STEP THREE:  Add Items and Properties 
 

Add items and their properties to the project in by navigating the Explorer, Table and 
Properties Panes within the Main Window. 

 
 Add the items you wish to include in the project  to each of the item categories 

(Invertebrates, Fishes, Birds, Mammals, Human, Chemicals, Environment) in the 
Explorer Pane.  

o In the Explorer Pane, click and highlight the item category you wish to edit. Items 
in this category will then appear in the Table Pane. 

o In the Table Pane, Click  to create a new item in the selected category.  To 
delete an item, select it and click .  

o In the Properties Pane, enter the name of the item in the Name text box. 
o Continue adding and naming items until all model items have been entered into 

the project. 
 

 Enter the properties of each item in the Properties Pane. 
o In the Explorer Pane, select the category of the item you wish to enter properties 

for. 
o In the Table Pane, select the item you wish to add properties to. 
o In the Properties Pane, add all properties.  

 For General and Specific properties: 
 For those properties with a : Click the  and select an item from 

the drop down menu. 
 For those properties with a : If the input value is known with 

certainty, simply enter the known value in the text box. If the input 
value is uncertain, click the  and enter four values representing 
the range of possibilities according to trapezoidal fuzzy numbering 
(See section Part V section 3). 

 For Toxicity and Diet properties: 
 Click the  next to the property. A table will appear where you 

can input related items by clicking  and selecting from a drop 
down menu of options. Then specify any remaining information in 
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the table relating the items in the property table to the selected 
item. 

o Continue selecting items and adding properties until all properties have been 
specified. 

 
STEP FOUR:  Save Completed Project 
 

 Click  to name and save the project.  The Save Project As… window will appear 
prompting the user to assign a name and location to save the new TT project. Select the 
desired location and name the project, then click Save.  This will save the project and 
return you to the Main Window. 

 
STEP FIVE:  Calculate and display results 
 

 Click   to run the model calculations and view the report. After the calculation has 
completed, the ReportViewer window will appear showing risk assessment results for the 
project. 

 
STEP SIX:  Save Results 

 
 In the ReportViewer window, save the project risk assessment results by clicking . 
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Part V:  BRAMS Modeling Framework 
 
This part summarizes the theoretical foundation of the Trophic Trace and BEST models in terms 
of input parameters, assumptions, and risk calculations. The information also provides a basis for 
comparison between the two models in BRAMS.  
 
1. Modeling Framework in Trophic Trace2* 
 
 
11.1 Gobas Model for organics 
 
The model used to estimate fish body burdens for hydrophobic organic compounds relies on a 
steady-state uptake model based on the approach of Gobas (1993 and 1995): 
 

𝐶𝑓 =
௞ଵ∗஼wdା௞ௗ∗஼diet

௞ଶା௞௘ା௞௠ା௞
     

 (1) 

Where: 
k1  =  gill uptake rate (L/Kg/d) 
Cwd  =  freely dissolved concentration in water (ng/L) 
kd  =  dietary uptake rate (d-1) 
Cdiet  =  concentration in the diet (g/kg) 
k2  =  gill elimination rate (d-1) 
ke  =  fecal egestion rate (d-1) 
km  =  metabolic rate (d-1)  
kg  =  growth rate (d-1) is not used in calculations (consider equal = 0) 
Cf  =  concentration in fish (g/kg) 

 

Several sources provide equations for the rate constants (k2, ke, km and kg) and these are 
described in greater detail in von Stackelberg et al. (2002).  

 
Biota-sediment accumulation factor (BSAF) 

Biota-sediment accumulation factors (BSAFs) used in the model are ratios that describe the 
relationship between the concentration of a nonpolar organic chemical in the lipid phase in tissue 
of a sediment-dwelling organism to the concentration in the sediment organic carbon phase to 
which the organism is exposed. BSAFs are defined as: 

 

BSAF = ( CB / fL )/( CS / fOC)   (2) 

                                                 
2    * This section is adapted from the TrophicTrace 4.0 Users Manual.  
 von Stackelberg, K. and A. Burmistrova. 2004. TrophicTrace 4.0 Users Manual: A Tool for Assessing Risks 
from Trophic Transfer of Sediment-Associated Contaminants. January 28, 2009. 34 pp. 
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Where: 

CB = concentration of contaminant in biota, mg/kg wet weight 
fL = the fraction lipid of the biota, kg lipid/kg wet weight 
CS = the concentration of contaminant in sediment, mg/kg dry weight 
fOC = the fraction organic carbon in sediment, kg organic carbon/kg  

dry weight 
 

CB = CS * ( fL / fOC) * BSAF   (3) 

 
Where: 

CB = concentration of contaminant in biota, mg/kg wet weight 
fL = the fraction lipid of the biota, kg lipid/kg wet weight 
CS = the concentration of contaminant in sediment, mg/kg dry weight 
fOC = the fraction organic carbon in sediment, kg organic carbon/kg dry weight 
BSAF = biota-sediment accumulation factor (typical assumption is 1.0) obtained from 
     site-specific measurements or literature sources 

 
The model can also accept a measured invertebrate concentration resulting from the standard 
Tier 3 28-day bioaccumulation test results.  To account for the fact that these measured 
concentrations may not have achieved steady-state, a Kow-dependent adjustment is made 
(McFarland, 1984; Connell and Hawker, 1988) automatically within BRAMS based on the 
following formula: 
 
  log tss = 6.9 x 10-3(log Kow)4 - 1.85 x 10-1(log Kow)3 + 1.65(log Kow)2 - 5.34(log Kow) + 5.93 (4) 
 
Where: 

tss = time required to reach steady-state 
 
 
11.2 Trophic Transfer Factor (TTF) and Bioconcentration Factor (BCF) for 

inorganic and hydrophilic organic compounds 
 
Estimates of fish burdens for inorganic and hydrophilic organic compounds rely on two different 
approaches, depending on data availability.  The first approach is a trophic transfer factor (TTF) 
from prey to predator approach, and the second is a bioconcentration factor (BCF) approach. For 
some chemicals, there are data available on bioaccumulation from invertebrates to fish (Dillon, 
1995).  Currently, TTF are available for copper, cadmium, lead, zinc, and arsenic. In the BCF 
approach, water concentrations are multiplied by a bioconcentration factor to estimate fish body 
burdens.  Water concentrations can either be provided by the user or estimated by the model 
assuming equilibrium partitioning from sediment.  
 
Both the food web model for hydrophobic organic compounds and the BCF approach for 
inorganic and hydrophilic organic compounds require a freely dissolved water concentration as 
an input.  Trophic Trace incorporates two approaches for estimating a freely dissolved water 
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concentration: 1) a user-specified freely dissolved water concentration from site-specific data; 2) 
from a subroutine (equation  5) using either a user-specified whole water concentration or an 
estimated whole water concentration (calculated by assuming equilibrium partitioning from a 
user-specified sediment concentration).  The subroutine that estimates a freely dissolved water 
concentration is shown in equation  5: 

𝐶wd =
1

 

 (5) 
 
 
Where: 

Cwd =   freely dissolved concentration in water (ng/L) 
DOC =   dissolved organic carbon (mg/L) 
DEoc =   density of organic carbon (0.041 mg OC/mg)  
Koc =   organic carbon/water partition coefficient (L/kg OC) 
POC =   particulate organic carbon (mg/L) 
Cww =   whole water concentration (ng/L) 

 
 

If a whole water concentration is not available, the program uses equilibrium partitioning with 
sediment to estimate a freely dissolved water concentration. The equation for organic 
contaminants is: 

 

           (6) 
 

Where: 
Cw  = concentration of freely dissolved chemical in the water (g/L) 
Coc = the organic carbon-normalized sediment concentration (g/kg dry wt sediment) and  
Koc = organic carbon-water partition coefficient  (L/kg organic carbon)  

  
The Koc for each chemical can be estimated from its octanol-water partition coefficient, Kow, 
according to the following regression relationship (Connell and Hawker, 1988): 

 
 
   log Koc = 0.00028 + 0.983 log10Kow                           (7)  

 
 
11.3 Risk Assessment Formulas  

 
Human Health Risk 
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The estimates of fish body burdens represent point estimates of concentrations to which humans 
are exposed via fish ingestion. These fish tissue concentrations are used along with exposure 
assumptions specific to each human receptor population to calculate carcinogenic risk and non-
carcinogenic hazard indices. Carcinogenic risk is calculated as follows:  

 

Risk =
CSF∗IR௙∗஼௙∗ED

BW∗1000000∗AT
   (8) 

is always equal 70 (constant) 
 
 
 
Where: 

Risk =   incremental lifetime cancer risk  
CSF =   cancer slope factor (mg/kg-day)-1 
IRf =   annualized fish ingestion rate (g/day) 
Cf =   concentration in fish (g/kg)           
ED =   exposure duration (days) 
BW =   body weight (kg) 
AT =   averaging time (days) is always equal 70 (constant) 

 
Non-carcinogenic hazard indices are calculated as follows: 

HI =
IR𝑓 ∗ 𝐶𝑓 ∗ ED

RfD ∗ BW ∗ 1000000 ∗ AT
 

    (9) 
 
 
 
Where: 

HI =   hazard index  
RfD =   Reference dose (mg/kg-day) 
IRf =   annualized fish ingestion rate (g/day) 
Cf =   concentration in fish (g/kg)           
ED =   exposure duration (days) 
BW =   body weight (kg) 
AT =   averaging time (days)  

 

Ecological risk 
 

Potential ecological risks are evaluated by comparing predicted contaminant concentrations in 
tissue and/or daily dose estimates to appropriate toxicity reference values (TRVs).  These 
comparisons are based on predicted tissue concentrations in mg/kg for fish, and on predicted 
daily dose estimates for the higher order ecological receptors. 

 

TRVs are levels of exposure associated with either Lowest Observed Adverse Effects Levels 
(LOAELs) or No Observed Adverse Effects Levels (NOAELs).  They provide a basis for 
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judging the potential effects of measured or predicted exposures that are above or below these 
levels.  TRVs are contaminant- and species-specific and are developed based on laboratory or 
field studies.   

 

Use of both LOAELs and NOAELs provides perspective on the potential for risk as a result of 
exposure to contaminants in dredged materials.  LOAELs are values at which effects have been 
observed in either laboratory or field studies, while the NOAEL represents the lowest dose or 
body burden at which an ecologically relevant effect was not observed.  Exceedance of a 
LOAEL indicates a greater potential for risk. 
 

Some studies examine toxicity endpoints (such as lethality, growth, and reproduction) that are 
thought to have greater potential for adverse effects on populations of organisms than other 
studies. Other studies examine toxicity endpoints such as behavior, disease, cell structure, or 
biochemical changes that affect individual organisms, but may not result in adverse effects at the 
population level. For example, toxic effects such as enzyme induction may or may not result in 
adverse effects to individual animals or populations. The procedure in Trophic Trace is to 
develop TRVs from studies that examine the effects of contaminants on lethality, growth or 
reproduction.  Studies that examined the effects of contaminants on other sublethal endpoints are 
not used to select TRVs unless no other studies are available. Lethality, growth, and 
reproductive-based endpoints typically present the greatest risk to the viability of the individual 
organism and therefore of the population’s survival. Thus, these are considered to be the 
endpoints of greatest concern. 
 
When exposures are expected to be long-term, data from studies of chronic exposure are 
preferable to data from medium-term (subchronic), short-term (acute), or single-exposure studies 
(USEPA, 1997c).  Bioaccumulative substances are by definition persistent, and exposure of 
ecological receptors to these contaminants from dredged materials is expected to be long-term, 
and therefore studies of chronic exposure are preferentially used to select TRVs.  Long-term 
studies are also preferred since reproductive effects of contaminants are typically studied after 
long-term exposure.  
 
Dose-response studies compare the response of organisms exposed to a range of doses to that of 
a control group. Ideally, doses that are below and above the threshold level that causes adverse 
effects are examined. Toxicity endpoints determined in dose-response and other studies include: 
 

 NOAEL (No-Observed-Adverse-Effect-Level) is the highest exposure level shown to be 
without adverse effect in organisms exposed to a range of doses. NOAELs may be 
expressed as dietary doses (e.g., mg contaminant consumed/kg body weight/d), as 
concentrations in external media (e.g., mg contaminant/kg food), or as concentrations in 
tissue of the affected organisms (e.g., mg chemical/kg egg). 

 
 LOAEL (Lowest-Observed-Adverse-Effect-Level) is the lowest exposure level shown to 

produce adverse effect in organisms exposed to a range of doses. LOAELs may also be 
expressed as dietary doses (e.g., mg contaminant consumed/kg body weight/d), as 
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concentrations in external media (e.g., mg contaminant/kg food), or as concentrations in 
tissue of the effected organisms (e.g., mg chemical/kg egg). 

 
 LD50 is the Lethal Dose that results in death of 50% of the exposed organisms. Expressed 

in units of dose (e.g., mg contaminant administered/kg body weight of test organism/d). 
 
 LC50 is the Lethal Concentration in some external media (e.g., food, water, or sediment) 

that results in death of 50% of the exposed organisms. Expressed in units of 
concentration (e.g., mg contaminant/kg wet weight food). 

 
 ED50 is the Effective Dose that results in a sublethal effect in 50% of the exposed 

organisms (mg/kg/d). 
 

 EC50 is the Effective Concentration in some external media that results in a sublethal 
effect in 50% of the exposed organisms (mg/kg). 

 
 CBR or Critical Body Residue is the concentration in the organism (e.g., whole body, 

liver, or egg) that is associated with an adverse effect (mg contaminant/kg wet wt tissue). 
 

 EL-effect is the effect level that results in an adverse effect in organisms exposed to a 
single dose, rather than a range of doses. Expressed in units of dose (mg/kg/d) or 
concentration (mg/kg). 

 
 EL-no effect is the effect level that does not result in an adverse effect in organisms 

exposed to a single dose, rather than a range of doses. Expressed in units of dose 
(mg/kg/d) or concentration (mg/kg). 

 
Most USEPA risk assessments typically estimate risk by comparing the exposure of receptors of 
concern to TRVs that are based on NOAELs.  Example TRVs included in Trophic Trace are 
developed on the basis of both NOAELs and LOAELs to provide perspective on the range of 
potential effects relative to measured or modeled exposures. 
 
Differences in the feeding behavior of aquatic and terrestrial organisms determine the type of 
toxicity endpoints that are most easily measured and most useful in assessing risk.  For example, 
the dose consumed in food is more easily measured for terrestrial animals than for aquatic 
organisms since uneaten food can be difficult to collect and quantify in an aqueous environment.  
Therefore, for aquatic organisms, toxicity endpoints are more often expressed as concentrations 
in external media (e.g., water) or as accumulated concentrations in the tissue of the exposed 
organism (also called a “body burden”).  In some studies, doses are administered via gavage, 
intraperitoneal injection into an adult, or injection into a fish or bird egg.  If appropriate studies 
are available, TRVs in Trophic Trace are selected on the basis of the most likely route of 
exposure, as described below: 
 

 TRVs for fish are expressed as critical body residues (CBR) (e.g., mg/kg whole body 
weight and mg/kg lipid in eggs). 
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 TRVs for terrestrial receptors (e.g., birds and mammals) are expressed as daily dietary 
doses (e.g., mg/kg whole body wt/d). 

 
 TRVs for birds are also expressed as concentrations in eggs (e.g. mg/kg wet wt egg). 

 
 
The toxicity quotient in ecological risk assessments is calculated as follows: 

 
(10)  

  
 
 
 
Where:             

TQ =   Toxicity Quotient  
IRf =   annualized ingestion rate (kg/day) 
Cf =   concentration in prey (mg/kg)           
frac =   fraction in diet  
TRV =   toxicity reference value (mg/kg/day) 
BW =   body weight (kg) 

  

  BW  TRV  

TQ 
C f frac 

* 

f  IR * *  
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12. Framework for BEST Model 
 
The BEST model framework is based on the 1999 EPA Region 1 Bioaccumulation Risk 
Assessment Model. 
 
12.1 Invertebrate tissue concentration 
 
The BEST model predicts invertebrate tissue concentration using 28-day bioaccumulation test 
results and chemical properties in the following equations for metals and organics respectively. 
 
Equation 1: BEST Formula for Invertebrate Edible Tissue Concentration (Metals) 
 

[Edible Tissue Invertebrate, Metal] (mg/kg) = [Cprey] x SSCF 
 
Where:  

[Edible Tissue Invertebrate, Metal] = Concentration of metal contaminant in edible tissue of 
invertebrate species (µg/g) 
 [Cprey] = concentration of contaminant in the invertebrate in the maximum replicate of 
five replicates from the 28-day bioaccumulation test data depending on the user’s choice 
(µg/g) 
SSCF = steady state correction factor (unitless) 

 
Equation 2: BEST Formula for Invertebrate Edible Tissue Concentration (Organics) 
 

[Edible Tissue Invertebrate, Organic] (mg/kg) = [Cprey] x SSCF 
   1000 

Where:  
[Edible Tissue Invertebrate, Organic] = Concentration of organic contaminant in edible tissue of 
invertebrate species (mg/kg) 
 [Cprey] = concentration of contaminant in the invertebrate in the maximum replicate of 
five replicates from the 28-day bioaccumulation test data (ng/g) 
SSCF = steady state correction factor (unitless) 
1000 = Unit Normalization Factor [Edible Tissue Invertebrate, Organic]  (ng/g  µg/g) 

         
12.2 Trophic Transfer 
 
The BEST model predicts the chemical concentrations in predator species by applying a trophic 
transfer model to the measured contaminant concentrations in the benthic invertebrate test 
species using the following equation: 

 
Equation 3: BEST Formula for Body Burdens in Predator Tissue  

 

[EdibleTissuePredator] (mg/kg) =  [𝐸𝑑𝑖𝑏𝑙𝑒𝑇𝑖𝑠𝑠𝑢𝑒𝐼𝑛𝑣𝑒𝑟𝑡𝑒𝑏𝑟𝑎𝑡𝑒] × 𝐵𝑀𝐹 × ൬
௅௜௣௜ௗುೝ೐೏

௅௜௣௜ௗುೝ೐೤
൰  
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Where:  

[Edible TissuePredator] = Concentration of contaminant in edible tissue of predator (mg/kg) 
[Edible Tissue Invertebrate] = Concentration of contaminant in edible tissue of invertebrate 
species (mg/kg) 
LipidPred = predator mean lipid fraction (g lipid/g tissue) 
LipidPrey = invertebrate mean lipid fraction (g lipid/g tissue) 
BMF = biomagnification factor (unitless) 
 

 
12.3 Human Health Risk 

 
Once the edible tissue concentration is calculated using the trophic transfer model, the result is 
used to determine the dose to humans that consume these species. The lifetime average daily dose 
(LADD)  is calculated for cancer risks and non-cancer risks. 
 
The LADD is calculated using the following equation:  

 
Equation 4: BEST Lifetime Average Daily Dose Equation  

 
LADD (mg/kg-day) = ETC x FI x F x IR x ED                                   

                                                   BW x LT 
 
Where:  

LADD = Lifetime Average Daily Dose (mg/kg-day) 
 ETC = Edible Tissue Concentration of diet species (mg/kg) 
FI = Fraction Ingested (unitless) 
F = Frequency (days/year) 
IR = Fish/shellfish Ingestion Rate (kg/day) 
ED = Exposure Duration (years) 
BW = Body Weight (kg) 
LT = Lifetime (days) 

 
To determine the carcinogenic risk level, the LADD is multiplied by an oral cancer slope factor 
(CSF) according to the following equation: 
 

Equation 5: Standard Cancer Risk Equation  
 
                                               Cancer Risk = LADD x CSF                                                       
 
Where:  

 LADD = Lifetime Average Daily Dose (mg/kg-day) 
CSF = Oral Cancer Slope Factor (mg/kg) 
 

To determine the non-carcinogenic hazard (i.e., hazard quotient), the LADD is divided by a 
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reference dose (RfD) according to the following equation: 
 

Equation 6: Standard Non-cancer Risk Equation  
 
                                        Non-cancer Risk = LADD/RfD                                                          
 
Where:  

 LADD = Lifetime Average Daily Dose (mg/kg-day) 
RfD = Oral Reference Dose (mg/kg-day) 

 
 Non-cancer risks greater than 1 are considered indicative of potential health effects. For cancer 
risks, an acceptable risk range of 1x10-6 to 1x10-4 is typically applied. Risk thresholds can be set 
in the Risk Thresholds section of the General properties. 
 
 
 
 
12.4 Model Assumptions 
 
Trophic Transfer 
As previously described, the BEST risk model predicts edible tissue concentrations in predator 
species by applying a trophic transfer model to the measured concentrations in invertebrate test 
species (Equation 1) based on the results of the 28-day bioaccumulation testing. This approach 
assumes that the test species represent the prey species typically consumed by predators, and that 
100 percent of the organisms consumed are exposed to the dredged material. 
 
Steady State Correction Factor 
A steady state correction factor (SSCF) is used to correct for underestimates of prey tissue 
concentrations in standard 28-day bioaccumulation testing. Because the standard testing period 
(28 days) might not be long enough for the exposed organisms to reach a state of equilibrium 
with their environment, the SSCF is applied to further estimate prey tissue concentrations under 
natural exposure periods that are longer than the standard testing duration.  
 
Biomagnification Factor 
The biomagnification factor (BMF) accounts for accumulation of chemicals in predator tissues 
from consumption of invertebrate prey. Chemicals that biomagnify, or increase concentration up 
the food chain, will have BMFs >1 while those that do no biomagnify will have BMFs ≤ 1. 
 
Toxicity Equivalency Factor 
To address potential toxicity for dioxin compounds and for selected PCBs and PAHs, a toxicity 
equivalency factor (TEF) approach should be applied by the user. In this approach, specific 
compounds for which toxicity information are uncertain or unavailable are assigned a TEF value 
that estimates their toxicity relative to a compound of known toxicity (called a TEF Reference 
Chemical in BEST). For example, individual dioxin congeners, as well as coplanar PCB 
compounds, should each be assigned a value ranging from 0 to 1 indicating their toxicity relative 
to 2,3,7,8-TCDD. The measured concentrations of these compounds are multiplied by the risk 
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factors (CSF and RfD) of the TEF Reference Chemical they are related to in order to determine 
their cancer and non-cancer risks.  
 
Risks 
As previously discussed, the BEST model estimates the carcinogenic and non-carcinogenic risk 
to human health based on the consumption of species directly exposed to contaminants in the 
sediment and their predators using standard risk equations (EPA, 1989b) based on the lifetime 
average daily dose (LADD) and.average daily dose (ADD), respectively.  
 

 
13. Interval Analysis of “Fuzzy Math” to Characterize Parameter Uncertainty 

In Trophic Trace3* 
 

13.1 Trapezoidal fuzzy numbers 
 

A trapezoidal fuzzy number is simply four numerical values [A, B, C, D] where A is less than or 
equal to B, B is less than or equal to C, and C is less than or equal to D. For the fuzzy parameter 
F=[A, B, C, D] the interval [A,D] represents the plausible range of the parameter. The number A 
is the minimum possible value of the parameter, and D is the maximum possible value of the 
parameter. The range [B,C] is the most likely range of the parameter F. So, fuzzy results yield 
both “worst case” and “best estimates” simultaneously. 
 
Trapezoidal fuzzy numbers is an example of a fuzzy set and could be represented via its 
membership function showing the degree of membership for each value of the parameter (see 
Figure 20). 
 

 
 

 

Degree of membership is a number between 0 and 1. The range of certain values of the 
parameter have a membership level equal to one (green line on Figure 19 corresponding to the 
interval [B,C]), restricted values with a degree of membership equal to zero are shown in red. All 
other values are more or less possible in proportion to their membership degree. This approach 
allows us to consider the fuzzy set as a measure for possibility (Zimmermann, 1991).  Note that 
the y-axis does not represent a probability or likelihood.  The degree of membership in the fuzzy 
set is proportional, however, such that if the degree of membership = 1 (B to C, also called the 
likeliest or probable range), then the parameter value, given the inputs, will definitely be within 
that range.  The parameter may take on values from the sides of the trapezoid (A to B and C to 
D, also called the full or possible range), but these values are only “possibilities” with the degree 
of possibility reflected in the degree of membership.  For example, a value that has a degree of 

                                                 
3    * This section is adapted from the TrophicTrace 4.0 Users Manual.  
 von Stackelberg, K. and A. Burmistrova. 2004. TrophicTrace 4.0 Users Manual: A Tool for Assessing Risks 
from Trophic Transfer of Sediment-Associated Contaminants. January 28, 2009. 34 pp. 
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membership of 0.8 is much more possible than a value with a degree of membership that is only 
0.1. 

 

13.2 Example:  Interval 
 

In the case when all possible values of the parameter are equally plausible (e.g., equivalent to a 
uniform distribution), then the range of the parameter can be described by an interval and 
interval analysis is used to analyze a model with such parameters. The membership function for 
an interval is a stepped function (see Figure 21).  

 

 

 

This approach also provides the possibility to consider the interval [A,D] as a trapezoidal fuzzy 
number [A,B,C,D] with B=A and C=D, i.e. as the fuzzy number [A,A,D,D], and to use such 
parameters in modeling.  In this case, the short representation [A,D] can be used instead of 
[A,A,D,D]. 
 

13.3 Triangular Fuzzy Numbers as a Particular Case of Trapezoidal Fuzzy 
Numbers 

 
Trapezoidal fuzzy numbers also include fuzzy numbers with a triangular shape for the 
membership function. A triangular fuzzy number is evaluated as a trapezoidal fuzzy number 
[A,B,C,D] with B=C, i.e. [A,B,B,D]. Such a fuzzy number could be used for a quantitative 
description of a parameter for which a possible range is known together with a single most likely 
value.  This is shown graphically in Figure 22.  The short notation for a triangular fuzzy number 
is [A,B,D]=[A,B,D,D] 
 

 
 

 

13.4 Exact Parameter Value  

 
It might be possible to know or only have information for one value for some parameters in the 
model. The approach to treat them as a trapezoidal fuzzy number [A,B,C,D] with A=B=C=D: 
[A,A,A,A] allows the model to include such parameters simultaneously with other parameters 
that are more uncertain. Zadeh (1965) provides an implementation for processing of fuzzy 
numbers by the extension principle.  Note, that all following notations are equivalent: 
A=[A]=[A,A]=[A,A,A]=[A,A,A,A]; all denote standard (not fuzzy) numbers as the particular 
case of the fuzzy number. 
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Trophic Trace performs the extension principle for the model equation process, but approximates 
results by trapezoidal shapes, too. The approximation approach uses the vertex method (Dong 
and Shah, 1987) for computing a function of fuzzy variables. 

 

13.5 Arithmetic of Trapezoidal Fuzzy Numbers 
 

3.5.1 Addition 
 

According to the extension principle, the sum of two trapezoidal fuzzy numbers is also a 
trapezoidal number. The following formula provides the exact value used by Trophic Trace. 
 

[𝐴ଵ,𝐵ଵ, 𝐶ଵ, 𝐷ଵ]+[𝐴ଶ,𝐵ଶ, 𝐶ଶ, 𝐷ଶ]=[𝐴ଵ+𝐴ଶ,𝐵ଵ+𝐵ଶ, 𝐶ଵ+𝐶ଶ, 𝐷ଵ+𝐷ଶ]  (10) 

3.5.2 Subtraction 
 

As for subtraction, the extension principle provides an exact solution for this operation, as shown 
in the following formula. 
 

[𝐴ଵ,𝐵ଵ, 𝐶ଵ, 𝐷ଵ]-[𝐴ଶ,𝐵ଶ, 𝐶ଶ, 𝐷ଶ]=[𝐴ଵ-𝐴ଶ,𝐵ଵ-𝐵ଶ, 𝐶ଵ-𝐶ଶ, 𝐷ଵ-𝐷ଶ]  (11) 

3.5.3 Multiplication 
 

Trophic Trace uses the following approximate formula for multiplication of fuzzy numbers. 
 

[𝐴ଵ,𝐵ଵ, 𝐶ଵ, 𝐷ଵ]*[𝐴ଶ,𝐵ଶ, 𝐶ଶ, 𝐷ଶ]~[𝐴ଵ*𝐴ଶ,𝐵ଵ*𝐵ଶ, 𝐶ଵ*𝐶ଶ, 𝐷ଵ*𝐷ଶ]  (12) 

The vertex method is based on𝛼-cut conception and interval analysis. It can be shown that the 
exact solution of multiplying trapezoidal fuzzy numbers has a curvilinear trapezium shape (so 
the result of multiplication of trapezoidal fuzzy numbers is not trapezoidal itself: this is the 
prupose of using the “approximate” sign “~”.  We approximate the result by the trapezoidal 
fuzzy number anyway.  The vertexes of this curvilinear relationship are calculated using formula 
(12) from above. 
 
3.5.4 Division 
 
𝛼-cut conception and interval analysis provides the following formula used in the Trophic Trace 
model for operation of division of positive trapezoidal fuzzy numbers. 
 

[𝐴ଵ,𝐵ଵ, 𝐶ଵ, 𝐷ଵ]/[𝐴ଶ,𝐵ଶ, 𝐶ଶ, 𝐷ଶ]~[𝐴ଵ/𝐷ଶ,𝐵ଵ/𝐶ଶ, 𝐶ଵ/𝐵ଶ, 𝐷ଵ/𝐴ଶ]  (13) 
 
As in interval analysis, the multiplication and division of fuzzy numbers are inverse to each other 
only for the case when all fuzzy parameters are exact values (all four components are equal). If 
parameter F has plausible range [𝐴ଵ,𝐷ଵ] and the plausible range for parameter Y is [𝐴ଶ,𝐷ଶ], then 
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to obtain the minimum value for the parameter F/Y one needs to divide the minimum value of 
the parameter F by the maximum value of the parameter Y.  The maximum value of F/Y is 
obtained by dividing maximum F by minimum Y. 
 
3.5.5   Power operations 
 
The extension principle provides an exact solution for extending the exponent function for fuzzy 
numbers. 
 

EXP [𝐴ଵ,𝐵ଵ,𝐶ଵ,𝐷ଵ]=[EXP (𝐴ଵ), EXP (𝐵ଵ), EXP (𝐶ଵ), EXP (𝐷ଵ)]  (14) 
 
This function is the particular case of a power function for which the extension principle also 
provides the exact solution, as shown below. 
 

=[𝐴ଵಲమ ,𝐵ଵಳమ ,𝐶ଵ಴మ ,𝐷ଵವమ ]     (15) 
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APPENDIX B: ACRONYMNS 

 
ADDAMS USACE fate and transport modeling system 
BEST Bioaccumulation Evaluation Screening Tool 
BCF Bioconcentration Factor 
BSAF Biota Sediment Accumulation Factor (here used only as a benthic sediment 

accumulation factor) 
BRAMS Bioaccumulation Risk Assessment Modeling Software 
CSF Cancer Slope Factor (mg/kg-day)-1 
DOC Dissolved Organic Carbon 
ITM Inland Testing Manual 
Koc Log 
Kow Log-octanol water partitioning coefficient 
LADD Lifetime Average Daily Dose 
LOAEL Lowest Observed Adverse Effect Level for ecological receptors 
NJDA New Jersey Department of Agriculture 
NOAEL No Observed Adverse Effect Level for ecological receptors 
NY/NJ New York/New Jersey 
OTM Ocean Testing Manual 
PCBs Polychlorinated Biphenyls 
POC Particulate Organic Carbon 
RfD Reference Dose (mg/kg-day) 
TBP Theoretical Bioaccumulation Potential 
TT Trophic Trace 
TTF Trophic Transfer Factor (from invertebrates to fish) 
TRV Toxicity Reference Value for ecological receptors 
USACE United States Army Corps of Engineers  
USEPA United States Environmental Protection Agency 
 
 
 
 
 


